HAROKOPIO UNIVERSITY E$ t\&\“&; esa

2 Lth ADVANCED TRAINING COURSE IN LAND REMOTE SENSING

EO Based fire disaster management services

Burnt Area Mapping

Dr. Kontoes Haris, Herekakis Themistoklis,

Argyridis Argyros, Papoutsis loannis

INSTITUTE OF ASTRONOMY & ASTROPHYSICS, @
SPACE APPLICATIONS AND REMOTE SENSING —
IAASARS

1-5 July 2013 | Harokopio University | Athens, Greece

fi' HAROKOPIO UNIVERSITY ‘\\&Q\“‘; cSsa

INTRODUCTION

¢ Aim of this training is to present a methodology, developed by NOA, for
mapping burned areas (burnt scar mapping)

e The area of interest is near Ebros, Greece, where a large fire event took place
in 2011

e Software requirements:
¢ ERDAS Imagine 2011 (Orthorectification and Main detection process)
e ESRI ArcGIS >=9.3.1 (Refinements, noise removal)

e Datainput:
e LandSAT5_2011_evros.tif
e LandSAT5_2011_evros_mask.tif

3 fth ADVANCED TRAINING COURSE IN LAND REMOTE SENSING
1-5 July 2013 | Harokopio University | Athens, Greece




.

;:::? HAROKOPIO UNIVERSITY

Session Planning

e An overview of the methodology will be presented

¢ The methodology will be fully explained, to understand the reasons behind
each course of action

e whenitis required, the required actions will be marked explicitly
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STEP 1: Data Retrieval

The methodology is based on LandSAT 4,5 and 7 imagery

The data can be freely acquired from http://glovis.usgs.gov/

To map historical fires, advanced queries are performed, based on the
available metadata

For the purposes of this training section, the data have already been retrieved
(LandSAT5_2011_evros.tif, LandSAT5_2011_giannena.tif within the
FireMapping/InputDataset/ path)
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STEP 2: Image Mask Generation

NASA LEDAPS ( Land Ecosystem Disturbance Adaptive Processing System)
algorithm is applied to the original data, to generate three masks:

¢ Land Mask (0)

e Water Mask (1)

¢ Clouds Mask (2)

These masks have been converted to binary masks (1 where is land, other wise
0)

Applied at a later stage as a means of noise removal
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STEP 3: Image Orthorectification

¢ The ERDAS Imagine software is used for the orthorectification process

¢ Theinputimage (LANDSAT5_2011_evros.tif) and the reference image
(BASE_182032_2001_Band_5.tif) is required

e The ERDAS Imagine software is used to perform the transformation

e Actions to perform:
1. Open ERDAS Imagine software

2. Inthe contents panel, right click on the 2D_View section and select
“Open raster layer”

3.  Navigate to the FireMapping/InputDataset/ and open the
LANDSAT5_2011_evros.tif.

4. Click yes, if you are asked to create pyramid layers
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STEP 3: Image Orthorectification: ERDAS Imagine Panels

Useful ribbons of the ERDAS Imagine:
e Raster: Performs actions on
a raster band, such as
radiometric corrections, DRG0
geometric calibration, R
image classification etc

) A B @ HE ma W A

e Multispectral: It is available
when a multispectral
image is loaded. Enables
the definition of color
composites, histogram
stretching etc.

*  Panchromatic: It is loaded
when a panchromatic —
image is loaded. Performs e i T
similar operations to the ; e :
multispectral ribbon
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STEP 3: Image Orthorectification — Performing the process (1)

e Actions to perform:
1. From the File menu, the New 2D view is selected

2. The screen splits in two parts and in the context panel a new 2D View section
appears

3. The names of each view set are mentioned on the top part of the window

4. The base map is loaded in the second (right) screen of ERDAS by right clicking
in the 2D View #2, choosing Open Raster Layer and navigating to the
FireMapping\Step3_Georeferencing\BaseMap directory and selecting the
BASE_182032_2001_Band_5.tif file
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STEP 3: Image Orthorectification — Performing the process (2)

e Actions to perform:

1. If the loaded image appears
incorrectly, then on the
panchromatic ribbon, left click on
the general contrast (on the
diagram) button

2. From the popped-up panel, on the
range adjust select the dynamic
range adjust and click apply

3. To make the images move
simultaneously, from the home
ribbon, select from the linked views
drop down menu the linked views
and sync views options

4. Create an Inquire box:

- From the Home ribbon,
click on the inquire-
>inquire box.

- Resize the appeared wide

box, to contain the whole
image
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STEP 3: Image Orthorectification — Performing the process (3)

@ Set Geometric Model ===
° ACtiOnS tO perfor.m: Select the Model From: WTD::T:::;MWMM
q " SEEE RESOUACESAT RPC
1. From the Multispectral ribbon, select oot IND High e AP
the control points button (el
‘KREISMFSATHPC
thetic Aper Radar) I
2. In the menu appeared menu (Set P Tt 1
Geometric Model), from the Model :
List, select the Landsat option and (Cancel ) [_Hsb_
click OK B GCP Tool Reference Setup ]
Collect Reference Points From:
3. Inthe GCP Tool Reference window, ® boaoe Loy (eiziomo)

select the Image Layer option rofsstavm )

Vector Layer New Viewer)

Annotation Layer [New Viewsi)

4. Navigate into the 6P File [ ger)
FireMapping\Step3_Georeferencing\ AsciFle
BaseMap folder and load the KesboardOrly

BASE_182032_2001_Band_5.img file
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STEP 3: Image Orthorectification — Performing the process (4)

Actions to perform:
In the Landsat Model
Properties window add the
gr_dtm_corine_rproj.tif as the
elevation model file
(FireMapping/InputDataset/ ).

Aim of the orthorectification
process is to find the same
points in the unrectified image
(left) and the base image
(right)

The points should be spread as
much as possible

Proper points for the process,

are points on artificial

surfaces, like the edges of

buildings, roads etc e e

A number of ~12 gcps should
be sufficient for the
orthorectification process

3 fith ADVANCED TRAINING COURSE IN LAND REMOTE SENSING
1-5 July 2013 | Harokopio University | Athens, Greece

HAROKOPIO UNIVERSITY ‘\\&Q\“‘; cSsa

1.
2.

STEP 3: Image Orthorectification — Performing the process (5)

Actions to perform:
By using the tool create gcp a new gcp point can be added
The procedure is as follows:
— Click on the create gcp button
Target a point on the left image
Click again the create gcp button
Target the same point on the right image

A least number of 5 points is required to compute the model

To solve the model, after entering the gcp points, press the Solve geometric
Model button

If other points are entered on the base (or the reference image) after the
model computation, the orthorectifier computes the position of the new
point
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STEP 3: Image Orthorectification — Performing the process (7)

Actions to perform:

To create the orthorectified image, left click
on the open image resampling dialog

Set the path to
FireMapping\Step3_Georeferencing and
name the file
user_Georeferenced_LANDSAT5_2011_evro
s.tif

The parameters should be similar to these
on the left image

Press OK

Save the input (and reference) gcps from the
file->Save Input As (and Save Reference As)

Perform the same process for the mask
image
(user_Georeferenced_LANDSAT5_2011_evro
s_mask.tif)

Update Calixaiion

Output Map Information

Projection: UTM
Uris meter:
Numbes rows: 1 Nurmbes cohamns:
1nap pised edges o
- @

[ Resample
Oulput Fiec
7 gy
Caiboaionc
Cutert GeaModsl  Landsal
ElvaionSoucs 8 Fls O Constant ) Elsvation Lixasy
DTMFle  9-dm_come_poith v 5 (metes ]

192

Resample Method
[ —
Output Comers:
ULk 389595000000 S e 43425000000
ULy 4546495000000 = Ly 4520595000000

[ Fiom Inguie Box

Dutput Cel Sizes:
s 00000000000 =y 300000000000 =
s [EAE0000000000 . [ZA0000N00N0  pmeters

Force Sauare Pliels on Reprojecton [/
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STEP 4: Input Dataset Preparation (1)

. The three masks (land, water, and
cloud) are combined in one mask
(already combined)

. Each mask is represented by a single
value (0 — water, 1 -land, 2 —

clouds) -
*  The final mask is vectorized within |c“°'°9 Tree A X | Contents | Preview. | Description|
ArcGIS Folder Connections = " T
| £ CAANAX e ype
| & = (3 Dataset_preparation.mdb Personal Geodatabase]

. Actions to perform: e

= [ FireMapping

® EJ InputDataset

@ [ Step3_Georeferencing

= [ Stepd_Input_Dataset_Preparation
& L3 Dataset_preparation.mdb

1.  Open ArcCatalog

2. From the Catalog Tree, create a
Folder Connection to the
FireMapping Folder

3.  Rightclick on the
Step4_Input_Dataset_Preparation
subfolder and from the New menu,
select the Personal Geodatabase
option

4. Name the database
user_dataset_preparation.mdb
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STEP 4: Input Dataset Preparation (2)

e Actions to perform:

1. OpenArcMap (R =i 1
e U= Ul R
2. From the Add Data button, open the | =™ - |

user_georeferenced_landsat5_2011_e | e s oo rss &)
vros_mask.tif image RS o

3.  From the Catalog toolbox, go to
Toolboxes -> System Toolboxes ->
From Raster -> Raster to Polygon

4.  Asinput raster use the mask

5.  For the output, navigate to the o) (e o] [ | (e
user_dataset_preparation
geodatabase and save the polygons
with the name
user_georeferenced_landsat5_2011_e
vros_mask
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STEP 5: Core Processing — Classification and Filtering (1)

To detect burnt areas on a first step, a series of
indices needs to be computed

These indices are the Albedo index and the NBR
index

Computation of Albedo Index:

Actions to Perform:
From the Toolbox ribbon of ERDAS Imagine, open
the Model Maker tool

Open the
FireMapping/step5_core_processing/nbr_index.g
md

Press the Execute Model button

As input image set the
user_georeferenced_landsat5_2011_evros.tif

As output image set the
user_georeferenced_landsat5_2011_evros_albed
o_index.tif
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STEP 5: Core Processing — Classification and Filtering (2)

Computation of NBR Index:
Actions to perform:

From the Model Maker open the Open
the
FireMapping/step5_core_processing/nbr
_index.cmd

Press Execute Model

As input image set the
user_georeferenced_landsat5_2011_evro
s.tif

As output image set the
user_georeferenced_landsat5_2011_evro
s_nbr_index.tif

R e e S
Fie Edt Model Ted Process Help
SEDES s @ R ¢ F

NBR (Index)

INPUT RASTER

R - SWIR IR + SWIR

1 PROMPT_USER

11 _PROMFT_USER) fnin i

EMHERDIF

OUTPUT RASTER
S0 oty GLOBAL MIN
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STEP 5: Core Processing — Classification and Filtering (3)
& Fooniede Cosiction " inomlerg 6]
*  Anareais a possible burnt area, if all the b o i
following conditions are met:
. NIR < 60 ]
«  NBR<126 e — onkcn b
. Albedo < 50 o E— i o
_<wasu ==
. ERDAS has a rule-based classification
capability, enabling the user to classify image Savehs
pixels based on heuristic rules, such as the
above

¢ Actions to perform:

1. From the Raster Ribbon, From the -
Knowledge Engineer, open the Expert M Vonvlesige Ciacsborion (6 kel Sl 1 e
Classifier | SELECT THE CLASSES OF INTEREST.

Anvalabl Clasres Selocied Classer ta ]|
| |

2. Select the e |
FireMapping\Step5_Core_Processing\ o |
ifi_knowl_eng.ckb as knowledge base and e |
press Next Loed

Asoove Al ]|
|

3. Select the Burned class as the available class Soh. ]|

|
[— — ]

HAROKOPIO UNIVERSITY = \\QQ&: cSsa

STEP 5: Core Processing — Classification and Filtering (4)

U Actions to perform:

1. Setthe
user_georeferenced_landsat5_2
011_evros.tif as the NIR image

2. Set the respective images files
for the albedo and NBR indices
and Press Next

3. Inthe output classified image
field set the path
FireMapping\Step5_Core_Proces
sing and name the output image
user_landsat5_2011_evros_kno
wledge_processingl.img
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STEP 5: Core Processing — Classification and Filtering (5)

. Changes in present vegetation, under certain
conditions, could imply fire position

. A common vegetation index, is the NDVI
(Normalized Difference Vegetation Index)

. NDVI is computed as
(NIR-RED)/(NIR+RED)

. In ERDAS, NDVI can be computed from the raster
ribbon -> Unsupervised -> NDVI

. Actions to perform:
1. Open the NDVI computation window
2. Set as input file the

user_georeferenced_landsat5_2011_evros.tif

3. Set as output file the
user_georeferenced_landsat5_2011_evros_ndvi
_index.tif

4. 4. Perform the same process for the

landsat_2010_evros.tif
(FireMapping\Step5_Core_Processing\additiona
| data)
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STEP 5: Core Processing — Classification and Filtering (6)

. Computation of BaseSum43 and RefSum43 indices INPUT RASTER 2011 INPUT RASTER 2010
¢ These indices are computed as follows: {}
Base4+base3*base3_coef

Ref4+ref3*ref3_coef nI_PROMFT \jSER 4 FROMPT_USER

¢ Actions to perform:
band 4 + band3*coef3

1. In the model maker window load the
basesum_refsum.gmd model

2. As input image on the left, set the
user_georeferenced_landsat5_2011_eSTEP 5: Core
Processing — Classification and Filtering (6) vros.tif

3. As input image on the right, set the
user_landsat_2010_evros.tif

o7_PROMPT_USER
16_PROMPT_USER

OUTPUT RASTER 2011 OUTPUT RASTER 2010

4. As output image on the left, set the
user_georeferenced_landsat5_2011_evros_basesum4
3.tif

5 As output image on the right, set the
user_landsat5_2010_evros_refsum43.tif
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STEP 5: Core Processing — Classification and Filtering (7)

e Computation of NDVI thresholds oREFDVL

e Actions to perform: @

¢  Inthe model maker window load the
navi_threshold_index.cmd

e Setasinput the NDVI of the 2011 image
(user_georeferenced_landsat5_2011_evros_ndvi_in
dex.tif)

$nl_PROMPT_USER $a1_PROMPT_YSER(T} 3

Output thresholded NDVI

¢ Asoutput for the 0.2 threshold set the
user_georeferenced_landsat5_2011_evros_ndvi_02
_threshold.tif image

nd_PROMPT_USER d_PROMPT_USER

e Asouput for the 0.3 threshold set the
user_georeferenced_landsat5_2011_evros_ndvi_03
_threshold.tif

¢ Both should be saved in the
FireMapping\Step5_Core_Processing directory
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STEP 5: Core Processing — Classification and Filtering (8)

e Anareais a possible burnt area, if all the following conditions are met:
* BaseSum43!=0
e RefSum43!=0
* NDVlbase —thres <= - thres

e This action is performed for thres= 0.3 and thres = 0.2
e Based on this rule, a classification should be performed on the image

e Actions to perform:
¢ From the raster ribbon of ERDAS Imagine, open the Knowledge classifier

¢ Load the ndvi_knowl_03_eng.ckb
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STEP 5: Core Processing — Classification and Filtering (9)

Actions to perform:

Set the corresponding raster files
and press next

On the next window, set the
filename of the result as

user_landsat5_2011_evros_ndvi_

knowledge_processing_03.img

The result should be equivalent to

the image on the right

Perform the same action with the

ndvi_knowl|_02_eng.ckb
(user_landsat5_2011_evros_ndvi
_knowledge_processing_02.img)
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STEP 5: Core Processing — Classification and Filtering (10)

The three fire results

AND REMOTE SENSING

Threshold = 0.3

Threshold = 0.2

. user_landsat5_2011_evros_knowledge_processingl.img

. user_landsat5_2011_evros_ndvi_knowledge_processing_02.img

. user_landsat5_2011_evros_ndvi_knowledge_processing_03.img

Have to be vectorized for the following refinement process

For each of these rasters:
Actions to perform:

. Open ArcMap

. From the ArcCatalog tab, locate the Raster to Polygon, under system toolboxes-> conversion tools -> from raster

. Use the same names as the rasters without the file type extension

. Make sure that the Simplify polygons is not selected

. Save each vector in the FireMapping\Step6_post_processing\step6_geodatabase.gdb\ geodatabase
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STEP 5: Core Processing — Classification and Filtering (11)

. Differences in vegetation can be detected, by computing
changes of the NDVI index of two seasons.

. Computation of NDVI Difference by substraction of the
NDVI reference (2010) from the NDVI base (2011)

. Actions to perform:

. From the raster ribbon of ERDAS Imagine, from the
functions menu, open the two image functions.

. As input image on the left side, set the
user_georeferenced_landsat5_2011_evros_ndvi_index.t
if

. As input image on the right side, set the
user_landsat5_2010_evros_ndvi_index.tif

. As output image, set the
user_landsat5_2011_evros_ndvidiff.tif

. As operation, between the bands, select the
substraction
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STEP 6: Post Processing — refinements (1)

¢ Detected areas, contains different kinds of noise
e water areas were detected as burnt areas
e Salt and pepper noice
* False alarms

e Post processing step, contains a variety of refinement steps, aiming to clear false
alarms, salt and pepper noise etc.

e As natural grasslands produces many false alarms, due to changes to present
vegetation, which is caused by pasture, these areas should be removed.

e Araster mask is generated, based on the NDVI diff and the NDVIref (2010) which is
on a later step vectorized and refined with the Corine Land Cover (CLC), within the
ArcGIS environment
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STEP 6: Post Processing — refinements (2)
e Actions to perform:

¢ From the raster ribbon of ERDAS
Imagine, open the Knowledge
classifier

¢ Navigate to
FireMapping/Step6_post_processing
and load the ndvi_diff_mask.ckb

e On the classes dialog, set the positive
mask as active

¢ Set the paths to the respective
images

¢ Set the output image as
user_landsat_2011_evros_ndvi_diff_
mask.img and save it in the
Step6_post_processing folder
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STEP 6: Post Processing — refinements (3)

e Actions to perform:

e Open ArcGIS 10.0

* From the Catalog tab on the right, create a connection to the FireMapping Folder
¢ Navigate to the FireMapping/step6_postprocessing directory

e From the NOA toolbox, load (right click -> edit) the fire_diff_mask.tbx

e Correct the paths of the respective files

¢ Save the mask as user_landsat_2011_evros_natural_grassland_mask inside the
step6_geodatabase.gdb
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STEP 6: Post Processing — refinements (4)

Generation of final mask.

The final mask is computed with the following formula:
mask_base +mask_base*mask_ref

This mask should be later vectorized, to perform certain
masking

Notice that the georeferenced mask layers should be used
Actions to perform:

From the ArcToolBox, open the Raster Calculator Tool,
under System Tools-> Spatial Analyst Tools -> Map
Algebra

Set the following formula:

"LandSAT5_2011_evros_mask" +
("LandSAT5_2011_evros_mask" *
"landsat_2010_evros_mask “)

Set the output file name as
user_landsat5_2011_evros_final_water_land_cloud_ma
sk.tif

The mask is later vectorized in the same way as the
previous rasters
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STEP 6: Post Processing — refinements (5)

The remaining refinement process has been split in 5 parts, within the ArcGIS
environment

The first step aims to extract the fires that were detected due to data from the base
image
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STEP 6: Post Processing — refinements (6)

e The second step, extracts the centroids, of the fires, that where detected with the
0.2 and 0.3 NDVI thresholds from areas that had similar spectral profile in the base
and the reference image

3 4th ADVANCED TRAINING COURSE IN LAND REMOTE SENSING
1-5 July 2013 | Harokopio University | Athens, Greece

‘_,/.'.

2 ; . — s,
‘21 HAROKOPIO UNIVERSITY ‘\\&\?esa

STEP 6: Post Processing — refinements (7)

. In the third step, the centroids from the second step, are spatially joined with the burnt areas detected (100m buffer) from the initial process
and extracts the respected polygons.

. If the polygons were detected by the 0.2 NDVI threshold, then they are clipped with a natural vegetation mask
. If the polygons were detected by the 0.3 NDVI threshold, then they are clipped with a natural grasslands mask

. In the end all adjacent polygons are merged
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STEP 6: Post Processing — refinements (8)

¢ Inthe fourth refinement step, it is checked the area percentage of the burnt areas, detected from
the first process, with the areas extracted from the third refinement step

e Ifitis smaller than 80%, then the polygon remain as is, otherwise it is clipped with a mask, based
on Corine Land Cover, containing the natural vegetation and grassland areas
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STEP 6: Post Processing — refinements (9)

¢ The final burnt areas are consisted by the polygons, detected on the first and
fourth refinement step, with area greater than 50000 m?
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e Actions to perform:

and clicking edit

STEP 6: Post Processing — refinements (10)

¢ From the NOA.tbx, open each refinement step, by right clicking each process

e Check the properties and settings of each sub-process

e Set the proper path for each file, and rename the output of each file (prefix
the output names with the user_ prefix)

e Compare your result with the result given to you
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Feed from the media....

http://www.wwf.gr/
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Thank you for your attention
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